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Deployment Scenarios Overview

How you implement Zetadocs Delivery and Zetadocs Capture depends on the version of Microsoft Dynamics

installed. For brevity, this guide will refer to Microsoft Dynamics 365 Business Central on-premises as BC and

Microsoft Dynamics NAV versions as NAV plus their respective version e.g. NAV 2018.

Follow the actions below for the relevant Zetadocs edition:

Zetadocs Express

Version Actions

NAV 2015 and later or BC 1. Follow the Express Installation steps only.

NAV 2013 R2 and earlier 1. Follow the Express Installation steps.

2. Then follow the steps How to Install Zetadocs Client

on a Client PC. on each PC.

Zetadocs Delivery Essentials

Version Actions

NAV 2015 and later or BC 1. Follow the Express Installation steps.

2. Then follow the Delivery Essentials Configuration.

NAV 2013 R2 and earlier 1. Follow the Express Installation steps.

2. Then follow the Delivery Essentials Configuration.

3. Then the steps in Modifying NAV and BC Reports To

Work With Zetadocs Client Delivery

4. Then follow the steps How to Install Zetadocs Client

on a Client PC. on each PC.

Zetadocs Capture Essentials

Version Actions

NAV 2015 and later or BC 1. Follow the Express Installation steps.

2. Then follow the Capture Essentials Configuration.

NAV 2013 R2 and earlier 1. Follow the Express Installation steps.

2. Then follow the Capture Essentials Configuration.
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3. Then follow the steps How to Install Zetadocs Client

on a Client PC. on each PC.

Deployment Environments

You can deploy Zetadocs on the following deployment environments:

· On a Dynamics partner's test system.

· On premises at a customer site.

· On a server hosted for the customer.

On a Dynamics Partner's Test System

Note that if you are creating a test system for Zetadocs that contains multiple instances of NAV or BC, the

Zetadocs Client will only be installed in the latest version. 

To deploy Zetadocs on multiple versions, see technical note ZTN4416, how to install Zetadocs Client Components

for older versions of NAV on machines with multiple versions present.

On Premises at a Customer Site

It is recommended to implement a Zetadocs server only deployment on NAV 2015 and later or BC. However it is

also possible to deploy a Zetadocs hybrid deployment with the Zetadocs Client installed on each client machine on

NAV 2015 and later and BC to support features like fax delivery or local scanning. 

To deploy a Zetadocs hybrid deployment, follow the steps described in How to install Zetadocs Client on a client

machine and How to modify Reports to work with Zetadocs Client Delivery (if Zetadocs Delivery is required).

On Server Hosted for the Customer 

Zetadocs supports private hosted NAV or BC deployments. You will be able to take advantage of all Zetadocs

server only features without having to manage on premises servers. You can archive files using either SharePoint

Server or SharePoint Online. The Zetadocs Archive is not supported in a hosted NAV or BC environment.1

To deploy Zetadocs using ClickOnce, follow the steps described in How to deploy Zetadocs using ClickOnce. 

1Zetadocs Archive is not supported in a hosted environment due to the fact that both the NAV/BC Clients and the

NAV/BC Server require access to the Zetadocs Archive folder to function properly.

http://www.equisys.com/technotes/ZTN4416.htm
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Express Installation

This section contains the common installation instructions for all Zetadocs editions.  Complete these steps

regardless of whether you are installing Zetadocs Express, Zetadocs Delivery, Zetadocs Capture or any of the

advanced Plus editions.

Before You Start

Before you begin your installation, check the Equisys website for the latest software updates, tools and advice to

ensure you have everything you need.

Overview of the Installation Steps to be Performed on the NAV or BC Server

The common installation process comprises these steps:

1. Installing the Zetadocs Client and Zetadocs Help

2. Installing the Zetadocs Server Extensions

3. Setting up your Archive

4. Importing NAV and BC Objects and Interfaces

5. Importing the Configuration File

6. Licensing and Registration

7. System Testing

1. Installing the Zetadocs Client and Zetadocs Help

Zetadocs Client must be installed on the NAV or BC server for licensing and shared components.

Steps for Installing Zetadocs Client Components

1. Extract and run the Zetadocs product download.

2. Locate the Zetadocs Client folder of your product download, and run the Setup-All.exe file.

3. Choose the installation language and click Install. 

4. Follow the steps in the installation wizard, and review and accept the license agreement. 

5. Select the Administrator install type when prompted. You will be asked to create the templates folder. Select a

location and click Next to continue.

6. Complete the wizard to finish the install of the Zetadocs Client.

https://www.equisys.com/updates


Zetadocs Installation Guide6

© Equisys Ltd

Installing Zetadocs Help

To install the Zetadocs Help:

Version Action

NAV 2013 R2 and later Follow the steps below.

NAV 2013 and earlier Follow the steps Help files in the Appendix section, then

carry onto the next section below.

Help Server

To integrate the Zetadocs help files with the Microsoft Dynamics Help Server, copy the Zetadocs help files into the

main NAV Help file folder and update the table of contents file. This will enable your users to locate the help they

need.

1. Locate your product download and select all of the files present from this folder:

\Documentation\Zetadocs Help

2. Copy the files to the NAV Help Server folder. The path is similar for each version of NAV. For example, for NAV

2017 systems, copy the files to:  

C:\inetpub\wwwroot\DynamicsNAV100Help\Help\<languagecode>

This adds the help files into the Help Server, where they can be accessed by pressing F1 on a Zetadocs field.

 

3. Open the ToC_Additions.xml in file in a suitable text editor.

4. Copy the contents and paste them into the ToC.xml file near the bottom, and above the last </Node> tag.

5. Click Save.

The files will be added to the Table of Contents so the content can be easily browsed.

2. Installing the Zetadocs Server Extensions

The Zetadocs Server Extensions setup program installs all the Zetadocs server-side components for Zetadocs

Delivery and Zetadocs Capture. These components add support for all NAV/BC clients, include the Web client and

Universal app.

1. Locate the Zetadocs Server Extensions folder of your product download, and run the setup.exe file.

2. Follow the steps in the installation wizard to complete the installation.

For NAV 2015 or earlier you can skip steps 3 and 4 of this section and restart the NAV Server. If you are installing on

NAV 2016 or later or on BC please follow the steps below.
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3. A File explorer window will open by the end of the installation, please right-click the file RunMeAsAdmin.bat

and select the option Run as Administrator.

4. A PowerShell script will prompt you to select the version you wish to install the Zetadocs Control Add-in into.

IMPORTANT: You must restart the NAV or BC server to complete the installation. If you encounter any problems

using the Zetadocs Control Add-in install script , please refer to manual installation instructions in the Appendix

section.

Note: If you are using a load balanced Server, the Zetadocs Server extensions must be installed in all server

machines.

3. Setting up your Archive

Zetadocs provides two options for archiving your documents: 

· Archive to SharePoint using the Zetadocs SharePoint Extensions.

· Use the Zetadocs Archive. This allows you to archive files to a Network folder.

Archive to SharePoint

To archive documents to SharePoint, you need to add the Zetadocs SharePoint extensions to your SharePoint site.

This enables Zetadocs to archive documents with metadata. Metadata allows Zetadocs to identify and associate

documents in SharePoint with NAV or BC records as they pass through the sales and purchase processes. This

enables users to access the relevant documents quickly and easily.

Prerequisites

Zetadocs supports SharePoint Online (a module of Office 365) and premise based SharePoint servers. For the latest

technical information and details on the supported SharePoint versions, please see our website. 

SharePoint Online

Adding the Zetadocs SharePoint Online Extensions 

1. Locate the Zetadocs SharePoint Extensions folder of your product download.

2. Open the SharePoint Online folder.

3. Right-click Zetadocs SharePoint Extensions.ps1 file and choose Run with PowerShell.

4. Follow the steps in the script:

a. Enter the URL for the site where the Zetadocs functionality is required (for instance

https://company.sharepoint.com/mysite/)

b. Choose your SharePoint deployment: SharePoint Online or SharePoint Server

c. Enter an administrative user email and the password for this administrative user

5. The script will log out information, the text should be green and white. If there is any red text, please verify the

error and take the required action to resolve if the error message is clear. If required, please contact Equisys to

resolve any unclear errors.

http://www.equisys.com/zdnavtechinfo
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SharePoint Server

Adding the Zetadocs SharePoint Server Extensions

1. Locate the Zetadocs SharePoint Extensions folder of your product download.

2. Open the SharePoint Server folder.

3. Run the sharepointonlinemanagementshell_5326-1200_x64_en-us.msi to install the SharePoint Online

Management Shell.

4. Open the Sharepoint Online Management Shell as administrator.

5. From the shell browse to the Zetadocs SharePoint Extensions folder and run the Zetadocs SharePoint

Extensions.ps1 file.

6. Follow the steps in the script:

a. Enter the URL for the site where the Zetadocs functionality is required (for instance

https://company.sharepoint.com/mysite/)

b. Enter an administrative user email

c. Enter the password for the administrative user

7. The script will log out information, the text should be green and white. If there is any red text, please verify the

error and take the required action to resolve if the error message is clear. If required, please contact Equisys to

resolve any unclear errors.

Use the Zetadocs Archive

The Zetadocs Archive Service runs on a server machine on your network and handles the archiving of documents

captured and sent using Zetadocs. The Zetadocs Archive Service uses a SQL database to store the metadata and

act as an index for the archive.

Creating the Zetadocs Archive Folder

The archive requires a network folder. This folder is used to store captured documents, and you must provide users

with the relevant permissions to access this folder.   

1. Create a folder with the name "Zetadocs Archive".

The Zetadocs Archive Service searches for this exact name and it will not work with any other name.

2. Verify this location has sufficient disk space. 

For more information, see the technical note on requirements - ZTN4290.

3. View the folder's Properties. Select the Share tab and select Advanced Sharing.

4. Select the "Share this folder" checkbox, and add the share name "Zetadocs Archive".

5. Select the Permissions button, and add required users and groups.

o All users of Zetadocs require Read permissions. Add these individually or create a Zetadocs group.

o The Zetadocs Archive Service must have access to the folder. By default, it runs as Local System. The system

account requires FULL permissions for it to function correctly.

http://www.equisys.com/technotes/ztn4290.htm
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6. Return to the Properties for the folder and select the Security tab.

7. Select the Edit… button. In the window which appears, select Add…

o All users of Zetadocs require Read permissions. Add these individually or as a group.

o The Zetadocs Archive Service must have access to the folder. By default, it runs as Local System. The system

account requires FULL permissions for it to function correctly.

Installing the Zetadocs Archive Service

1. Locate the Zetadocs Archive Service folder of your product download and run the setup.exe file. 

Note: The Zetadocs Archive Service installer may require you to reboot your server to complete this task. 

The installer performs the following actions:

o Installs Microsoft SQL Server Express edition (or adds a new instance if already installed).

o Creates the SQL database for indexing and metadata.

o Installs the Zetadocs Archive Service.

2. Follow the steps in the installation wizard to complete the installation.

Connecting the Zetadocs Archive Service and Zetadocs Archive Folder When They are on Different Servers  

If you have setup the Zetadocs Archive folder on a different server to the Zetadocs Archive Service, you must

complete the steps below. These steps ensure the service can access the folder. 

This is not required if they are on the same server machine.

1. Locate the Zetadocs Archive Service\Scripts folder of your product download and run the

SetArchiveFolderLocation.cmd file.

2. In the window which appears, enter the server name where the Zetadocs Archive folder is located.

3. Ensure the Zetadocs Archive Service is running as is a domain user.

Ensuring Zetadocs Archive Service is Running as a Domain User

To ensure the user the Zetadocs Archive Service is running as a domain user, follow these steps:

1. Open Users and Groups (or the equivalent for the operating system you are using).

2. Select Users and then New User… from the Action menu.

3. Give the account a suitable user name, full name and description.

4. Enter a password for the account. 

Note: Before clicking Create, verify the Password never expires checkbox is selected.

5. Go to your Zetadocs Archive folder and view its Properties. Select the Share tab and Select Advanced Sharing.

6. Select the Permissions button and add your newly created user account with FULL permissions. 

7. Return to the Properties for the folder and select the Security tab.
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8. Select the Edit… button. In the window that appears, select Add…

9. Add the users and groups you created earlier. This grants your users and the Zetadocs Archive Service access to

the Zetadocs Archive folder.

10. Open the services list and locate the Zetadocs Archive Service. Stop the service before right-clicking and

selecting Properties.

11. View the Log On tab and check the This account radio button. Click Browse… and select your recently created

user account. 

12. Enter the password details and click OK.

13. Restart the service running as the new user.

4. Import Zetadocs Objects

This section describes how to: 

· Import the objects used by Zetadocs into NAV or BC.

· Modify some existing pages. Zetadocs Page Modification Tool is provided to automate this process.

Before you start - Creating a Test NAV or BC System

We recommend you perform the import of the Zetadocs objects and configuration data on a duplicate of your live

database. This can then be exported and transferred onto the live system when you are confident that it is

working correctly. 

Prerequisites

Before you continue with your Zetadocs install you need to perform the following prerequisite actions:

Refreshing your NAV or BC license

To successfully install Zetadocs you need to add the Zetadocs module (9009970) your NAV or BC license. Log into

PartnerSource to add the required module, then download an updated license.

Backing up the Existing Objects

Before beginning the Zetadocs installation you may wish to perform a backup of the existing objects to ensure

you can undo any changes to your system if required.

Importing the Zetadocs Objects

1. Open the NAV Development Environment and the relevant database.

2. Change to a NAV or BC license suitable for importing objects

3. From the object designer, import the fob file by selecting File > Import.

4. Browse to your product download and navigate to the Zetadocs Server Components folder.

5. Choose the object file relevant to your NAV version or BC .

https://www.equisys.com/support/knowledgebase/zdnav.htm?Product=Page%20Modification%20Tool
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Version Fob file to use

NAV 5.0 SP1 Zetadocs Objects - NAV5.00.fob

NAV 6.01 (2009 SP1) Zetadocs Objects - NAV6.01.fob

NAV 6.10 (2009 R2) Zetadocs Objects - NAV6.10.fob

NAV 7.00 (NAV2013) Zetadocs Objects – NAV7.00.fob

NAV 7.10 (NAV2013 R2) Zetadocs Objects – NAV7.10.fob

NAV 8.00 (NAV2015) Zetadocs Objects – NAV8.00.fob

NAV 9.00 (NAV2016) Zetadocs Objects – NAV9.00.fob

NAV 10.0 (NAV2017) Zetadocs Objects – NAV10.0.fob

NAV 11.0 (NAV2018) Zetadocs Objects – NAV11.0.fob

BC 13.0 (Business Central on-premises) Zetadocs Objects – BC13.0.fob

BC 14.0 (Business Central on-premises) Zetadocs Objects – BC14.0.fob

6. If there are no collisions with existing objects, continue importing the objects and ensure that there have been

no compilation errors. 

Modifying NAV and BC Pages Using the Zetadocs Page Modification Tool

The Zetadocs Page Modification tool makes the process of adding Zetadocs functionality to NAV or BC pages

quicker and easier.

The tool is designed to work with most pages and will notify you if there are any issues. For example, if the pages

have too many existing customizations. If you encounter any problems with the tool, follow the technical note

ZTN4275.

To modify the existing pages:

1. Download the latest Zetadocs Page Modification Tool from the Equisys website and extract it.

2. Open the Object Designer in the Dynamics NAV Development Environment.

3. Choose the All tab and click on the Table Filter.

4. Add this filter to select objects which typically need modifying:

Type ID Notes

Form|Page 21|22|26|27|41..44|
49..52|130|132|134|136|
138|140|142..147|438|440|
448|450|507|509|6630|
6640|6650|6652|6660|6662|
9300..9311

Forms are not compatible with NAV

7.0.

http://www.equisys.com/technotes/ztn4275.htm
https://www.equisys.com/support/knowledgebase/zdnav.htm?Product=Page%20Modification%20Tool


Zetadocs Installation Guide12

© Equisys Ltd

5. Apply the filter and review the list.

6. Select the required objects and go to File > Export.

7. Save the interfaces as:

o an XML file (NAV 6.x), or 

o as a TXT file (NAV 7.x and later or BC)

8. Now open the Zetadocs Page Modifier tool from the extract location and click Load Items and select your NAV

version or BC and your language.

9. Browse to the location of your exported Interfaces file and click Open. Wait while the tool loads your exported

items.

10. The loaded pages will be displayed. Enable Send adds the Zetadocs Send button, required for Zetadocs server-

side delivery and Zetadocs Express.

11. When Enable Send is checked, the type of page will be automatically populated if the tool recognizes that

page.

12. Click Start

o The tool will then prompt you to add the Rules button to the Customer and Vendor pages if included in the

export.

o The status column shows the conversion process. If an item cannot be modified, the reason will be listed in this

column. If you encounter any problems with the tools, follow the instructions in  ZTN4275

o The updated export file name will be appended (Modified) and can be viewed by clicking View Output

Directory.

13. Now use the Object Designer to re-import modified pages and forms and compile them (F11).

Note: On first use, the tool will create an AppSettings.xml file in the tool Directory to store the types specified. The

tool will load these settings automatically on next run to save time specifying them again. The AppSettings.xml

can be copied to another system if you wish to use the same types on that system.

Note2: The tool can remove the Zetadocs components when used in repair mode. This mode can be activated

from the drop down menu.

5. Importing the Configuration File

You must import the Zetadocs standard configuration file, as it populates your system with the base settings

Zetadocs requires.

Importing the Language Module

If you are intending to use a language other than English, you will need to import the relevant language module,

using the steps below. 

http://www.equisys.com/technotes/ztn4275.htm
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1. Complete this step, if required:

Version Action

NAV 2013 R2 and later or BC Carry out the additional steps in technical note

ZTN4301 how to Import language modules from NAV

2013 R2 and later or BC before proceeding with the

steps below.

NAV 2013 and earlier No action needed. Follow the steps below.

2. In the object designer, select the All view. 

3. Using a table, filter Version = EQ* to list all the Zetadocs objects.

4. Select all the highlighted objects and click Tools > Language module > Import.

5. Browse to the Zetadocs Server Components\Language Modules\ folder of your product download.

6. Import the language module for your region and your version.

Importing the Zetadocs Standard Configuration Data

This will import all data and default settings to all Zetadocs tables. This is a required step for each individual

Company in the NAV or BC Database.

To import the Zetadocs Standard Configuration Data:

2. Open the Zetadocs General Settings page.

3. A message may appear informing that the Windows Client needs permissions to run the

Zetadocs.ExternalUtilities.ZdAutomationFactory, select Always Allow.

4. Next, in the Actions Ribbon click Import Configuration Data.

5. Browse to the Zetadocs Server Components\Standard Configuration Data folder of your product download.

6. Select the relevant xml file for your language and version.

7. Click Import on the Home tab. 

o Two warning messages will appear. Select Yes to continue.

Archive Settings

1. If you are archiving documents using Zetadocs, you need to select your preferred method:

http://www.equisys.com/technotes/ztn4301.htm
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Archiving method Description

Off Zetadocs will not attempt to archive items.

SharePoint Enable this method to use SharePoint Server or

SharePoint Online(for NAV 2015 and earlier) to archive

your documents to.

SharePoint Online Enable this method to use SharePoint Online to archive

your documents. This method uses the Zetadocs

Authorization Service and is only available for NAV

2016 and later or BC.

Zetadocs Archive This enables Zetadocs Archive Service address field.

This needs to point to the Zetadocs Archive Service

installed when setting up your archive.

2. Enter a Document Library. The default value is Zetadocs.  

Note: If you are using the Zetadocs Archive Service or Zetadocs Express, you must use the default value

Zetadocs.

3. Set the library Folder Name Structure.

Note: Zetadocs Express will always use daily folders

o This subdivides archived documents into subfolders in the SharePoint document library, based on information

from the sent record. You have three levels to work with.

Choose the following options:

Item Description

COMPANY The recipient NAV or BC Customer name. e.g. Cronus Inc

DATE The Date with a format specified by the Date Folder

Naming property below. e.g. 03/30/2018.

DOCTYPE The Document Type as specified for the current

Zetadocs Document Set, or its override in the Zetadocs

Report Settings. e.g. Sales Orders. 

Note: This is not the SharePoint content type.

o When using Date, you need to specify the Date Folder Naming. This specifies the date format e.g. YYYY-MM-

DD, DD-MM-YYYY, MM-DD-YYYY etc. 

· Enter the name of the the service address:
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Archiving method Action required

If you are using SharePoint archiving Input the SharePoint site or site collection address as

required. This is the bold section shown here: 

https://equisys.SharePoint.com/sites/MicrosoftDyn

amics/default.aspx.

Note: You can click the button located at the end of

the SharePoint Site field to verify it.

If you are using the Zetadocs Archive Enter the server name on your network where the

Zetadocs Archive Service has been installed into the

Service Address field e.g.

http://example-server/ZetadocsArchive

Note: Ensure there are no spaces in the name.

7. When you have added the service address, click the test button at the end of the field to verify it. This will

open a browser window. If it is successful in connecting to the service, it will display a page titled ArchiveService

Service with the confirmation message. You have created a service below it.

Zetadocs Authorization Service (NAV 2016 and later or BC with SharePoint Online)

The ZAS simplifies identity for Office365 users when using SharePoint Online. Each Azure Active Directory (Azure

AD) user will follow a one-time Zetadocs Authorization Service app registration to enable this feature. Once

enabled, Zetadocs stores an Azure AD token in the NAV or BC database and uses this to access SharePoint. App

registration will also enable Office 365/Azure AD users that have multi-factor authentication (MFA) enabled to use

the Zetadocs FactBox without being prompted for a code each time. 

As Zetadocs is going to be storing Azure AD tokens in tables, it will requires Data Encryption Management to be

enabled before proceeding.

Zetadocs Delivery Settings

The Zetadocs Delivery Settings enable you to specify the delivery options applied to the Send Button for Zetadocs

server-side delivery. 

Version Action

NAV 2015 and later or BC Follow the steps below.

http://example-server/ZetadocsArchive
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NAV 2013 R2 and earlier No action needed. Skip to the next section.

Open the Zetadocs Delivery Settings page and fill in the options of your SMTP details. 

SMTP Settings

Zetadocs server-side delivery uses SMTP to send emails. The Zetadocs Delivery Settings page holds the SMTP

configuration settings that the Zetadocs will use to send emails. Specify on premise SMTP, Exchange online secure

mail settings, or other SMTP server.  

Setting Description

SMTP Server The SMTP server that the Zetadocs will use to send

emails.

SMTP Server Port The port of the SMTP server specified above.

Secure Connection This flag is used to specify if delivery will use a secure

connection with the SMTP server.

From The alias from each the email is sent.

User ID The user ID for the SMTP server.

Password The password of the above user for the SMTP server.

Importing the Zetadocs Permissions

Users in NAV or BC need to be granted permissions to access and edit fields. This also applies to the additional

Zetadocs objects. You now need to add permissions to allow users access to the Zetadocs elements.

To grant permissions to access and edit fields you will need to import the Zetadocs Permission Sets and

Permissions. Locate in the Zetadocs download folder the Zetadocs Permission Sets and Permissions - NAV7.xx-

NAV10.0-BC14.0.RAPIDSTART file and import it.

Assigning Users Permissions

Users using Zetadocs components will need to be given permissions to access and edit fields. To do so you can

assign the previously imported permission sets to Zetadocs users. There are 2 different permission sets for

Zetadocs:

· ZETADOCS – grants access to the standard Zetadocs pages, forms and tables and allows you to use Zetadocs.

· ZETADOCS ADMIN – grants the user the ability to adjust the setup of the system in more fundamental ways and

should be reserved to administrators only.
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6. Licensing and Registration

All editions of Zetadocs must be licensed and registered in order to receive technical support

Entering your License Number

1. On the NAV or BC server, run the Zetadocs PDF Configuration.

2. Choose General and set the license location  to Network Folder.

3. Select a Shared Network folder to save the license file. Ensure that the user that runs the NAV or BC server has

access to this Network location.

4. Choose Licensing and Registration, and enter your Zetadocs license number. Click Register Online and follow

the onscreen steps.

5. Following registration, you will be provided with a Registration code by email. Enter the code to continue.

6. Now use User Management to add the required users.

7. Now choose Save to save changes to the license file.

Version Action

NAV 2015 and later or BC Follow the steps below.

NAV 2013 R2 and earlier No action needed. Skip to the next section.

8. Launch the NAV or BC Windows client and open Zetadocs General Settings.

9. Set the License Path to the network path used to save the license file.

10. Close the Zetadocs General Settings.

7. System Testing

To ensure that the features have been correctly configured we recommend that you run a number of simple tests

of the Zetadocs functionality.

Note: Log into the Dynamics NAV Client with a Dynamics Full User license and a user role that has access to the

modified sections within NAV or BC.

Authentication with SharePoint on Office 365

1. Open NAV or BC and proceed to one of the Zetadocs enabled pages e.g. Sales Order page.

2. The Zetadocs Documents FactBox will display a login box requesting their Office 365 username and password.

3. Add these and select OK to continue, this establishes the connection between Zetadocs and SharePoint.

4. These details will be stored locally in Windows Credential Manager meaning that the user will only be requested

to provide them again should they be changed or a problem connecting occurs.

5. This should be repeated on all required user accounts.
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Drag and Drop Testing

1. Open the Dynamics NAV Client and open a page with the Zetadocs Documents FactBox.

2. Locate a suitable test file and drag and drop this onto the Drag files here to upload area of the FactBox.

3. Ensure this appears in the Related Document List and is archived.

Version Action

NAV 2016 and later or BC Follow the steps below.

NAV 2015 and earlier Follow the steps Save and Send Testing (NAV 2015 and

earlier), then carry onto How to install Zetadocs NAV

Client on a client machine.

Drag and drop from Outlook Testing

Microsoft Outlook does not support the functions browsers use to interpret files during drag and drop events. It is

therefore not possible to directly drag emails or attachments from Outlook onto the Documents FactBox. It

requires a two-stage process:

1. Drag an email to the desktop and then from desktop onto the FactBox.

2. Ensure the email appears in the Related Document List and can be opened.

3. Delete the email on the desktop.

Note: There are 3rd party add-ons for Outlook that can be installed to avoid this two-step process for any browser

based web applications. See ZTN4477 for more information

Universal App Testing

On the Universal app, the Documents FactBox is optimized for touch. With screen real estate at a premium, file

count is hidden and larger icons are presented for finger input. Drag files here to upload is only shown on clients

where drag and drop is applicable e.g. Web Client.

1. Tap the upload button to add related documents from the device gallery to the record on display.

2. Touch the document in the list to view previously archived files.

Save and Send Testing (NAV 2016 and later or BC)

1. Open the Dynamics NAV Client and navigate to a Sales Quote record, or other supported record type.

2. Click the Send button in the Zetadocs group on the Actions Ribbon to open the request filter auto-populated

with the selected record ID. Note: Record ranges to select batches are not available for Zetadocs Express, only with

Zetadocs Essentials.

3. Click OK and then confirm the customer addressing information presented.

4. On selecting OK an SMTP email message will appear in the Zetadocs Outbox briefly and disappear when saved

and sent successfully.

5. Check it was delivered as expected and that the document appears in the Documents FactBox.

Save and Send Testing (NAV 2015 and earlier)

1. Open the 32-bit Dynamics NAV Client and navigate to a Sales Quote record, or other supported record type.

http://www.equisys.com/technotes/ZTN4477.htm
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2. Click the Save and Send button and then Select the Save and Send option.

3. On selecting OK an Outlook email message should open with an attachment and with customer addressing

information already populated.

Note: On selecting Save and Send for the first time you will be presented with up to four warnings such as:

o Server has requested to run Scriptcontrol object

o Server has requested to run OApplication class

o Server has requested to run OSendMail class

o Server has requested to run BSTRConverter class

These are to be expected and you should simply select Always Allow in each instance, they will not appear again

on this machine.

4. Check it was delivered as expected and that the document appears in the Documents FactBox..

Now that you have made the necessary modifications to NAV or BC and tested the setup, you can install the

Zetadocs Client on the client PCs. To do this simply log onto client machine in question with an account with admin

rights and follow the instructions in the Appendix - How to Install Zetadocs Client on a Client PC. This will add all of

the necessary components onto the client PC to enable it to utilize the Zetadocs functionality. Its recommended

that you perform the tests above to confirm that Zetadocs is operating as expected on each client PC.

Next Step

This completes the installation and testing of Zetadocs Express. If you are not installing Zetadocs Delivery

Essentials or Zetadocs Capture Essentials your setup is now complete. 

If you have installed the software on a test setup, go to the next section migrating to a live environment.
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Delivery Essentials Configuration
This chapter covers how to modify the Zetadocs Delivery configuration to fulfill your specific requirements. 

Please ensure you have carried out the steps in the Express Installation, as its components are required to support

Zetadocs Delivery. Systems that are not implementing Zetadocs Delivery Essentials can skip this section.

About Zetadocs server-side delivery

For Dynamics NAV 2015 and later or BC, Zetadocs provides the option of a server-side deployment that

significantly simplifies the implementation as there are no Report modifications required and no software is

installed on the client PCs. Zetadocs server-side delivery is the recommended installation method on these newer

systems. For instructions on how to migrate to server-side delivery, please refer to How to migrate to Zetadocs

server-side delivery.

About Zetadocs Client Delivery

For all Dynamics NAV versions and BC it is also possible to deploy Zetadocs in a hybrid deployment with the

Zetadocs Client installed on each client machine to support Zetadocs Delivery features like fax delivery and

electronic signatures. 

To deploy a Zetadocs hybrid deployment, follow the steps described in How to install Zetadocs Client on a client PC

and How to modify Reports to work with Zetadocs Client Delivery. 

How to modify the Zetadocs Delivery configuration:

Version Action

NAV 2015 and later or BC Follow each section below.

NAV 2013 R2 and earlier Follow each section below unless specified to ignore.

1. Updating the Zetadocs Report Settings to Match your Reports

The Zetadocs Standard Configuration data points to the default report objects. You now need to adjust this to

match your Report ID’s.

Note: To enable NA Customer Statement reports please see Appendix on How to add support for NA Customer

Statements(10072) after completing the steps below.

https://www.equisys.com/technotes/ztn4488.htm
https://www.equisys.com/technotes/ztn4488.htm
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Zetadocs Report Settings table

The Zetadocs Report Settings table allows you to record information about the rules that apply to these reports. It

covers the rules used to send reports as well as how to archive the report.

General

Field Description

Report ID The unique value given to identify each report.

Report Name This field is populated when Report ID is selected. It

contains the Name that matches the Report ID

Comments Allows you to add additional information to the

record.

Document Set No. Corresponds to the key field of the Zetadocs System

Rule table linking the report to rules for its distribution.

Document Set Name Contains the name of the rule that is being applied to

the report. It is determined via the Document Set No.

selection

Default Batch Name The default name to be given to the batch that will

appear in the Zetadocs Client.

Report Mappings (Zetadocs server-side delivery only)

Field Description

Report Table ID Specifies what is the ID of the main table of the

report.

Report Table Filter Refers to the Where clause of the DataItemTableView

on the main DataItem of the report. (e.g.: Document

Type=CONST(Quote))

Report DataItem Name Refers to the name of the main DataItem

Table Mapping

Setting Description

Company Type Code Links the Zetadocs Report Settings table with the

Zetadocs Company Type table. The type allows us to

add additional ways to locate recipient details.

Examples of this would be CUST, VEND.

Company No. Field No. Identifies the company associated with the report.

Contact No. Field No. Directs the NAV or BC to look for the Contact No. in

the relevant table in the Field No. specified. For
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Setting Description

example if the report covered a particular Vendor then

the value in this field would identify the location of

the Contact No. in the vendor table.

Record No. Field No. Directs the NAV or BC to look for the Record no. in the

relevant table in the Field specified. For example if the

value was 5 the the system would look in field 5 for

the Record No.

Options

Setting Description

Show Delivery Dialog Determines whether or not to display the delivery

dialog for overriding send information at runtime.

Show Batch Delivery Dialog Determines whether or not to display the batch

delivery dialog for overriding send information at

runtime.

Preview in Zetadocs Client Determines whether or not to preview on the Zetadocs

Client before sending information.

Test Mode Activates the default test mode settings.

Note: This setting is only supported with Zetadocs

Client Delivery.

Report Pre-Processing If the report is based on more than one Report

DataItem, please check this option.

To modify or add report settings open the Zetadocs Report Settings page and follow the steps below:

1. Select a report and use the Document Set Name as your guide to the respective report setting.

2. Select the Report ID field and choose your modified report from the Object list.

3. Repeat the process for any remaining reports as required.

Note: A report can only be associated with one Zetadocs Document Set, but many reports can be associated with

one Zetadocs Document Set.

Setting NAV or BC to run the correct reports

Set NAV or BC to run the modified reports instead of the original ones by adjusting Report Selections. 

Note: You do not need to perform this step if you have modified your reports and kept the default Report IDs.

In this example, we will set the modified Order Confirmation report. Repeat this process for each new report being

used.
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To run the modified reports:

Version Action

NAV 2013 and later or BC Search for Report Selections Sales and select the Order

report from the drop down.

NAV 2009 1. Open the Dynamics NAV Client 

2. Select Administration >  Sales & Marketing >  Report

Selections and choose the Order report.

3. Click into the Report ID field and select the arrow to

open the Objects list.

4. Select the new object from the list, in this case

9009962 ZD-Order Confirmation.

5. Repeat as required for the other reports.

2. Job Queues

Note: These settings are only applicable on NAV 2015 and NAV 2016, for Zetadocs server-side delivery. 

About Zetadocs Delivery Queue and Zetadocs Batch Delivery Job Queues

Zetadocs Delivery Queue and Zetadocs Batch Delivery Job Queues are created during the Zetadocs configuration

settings import. These two queues ensure that the individual reports that need to be sent urgently don't get held

up by large batches. 

Any running batches in the Zetadocs Batch Delivery Queues, or individual emails being sent by the Zetadocs

Delivery Queue, can be viewed using the Zetadocs Delivery Outbox for the submitting NAV user.  

About Job Queue Category Lists 

Zetadocs also provides one Job Queue Category List for each Job. It creates two categories: one for individually

sent documents and another for batches containing multiple documents. 

Job Queue and Job Queue Category Lists are created automatically by Zetadocs when you open the Zetadocs

General setting page.

Checking the Job Queues are Running
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1. Check the “Job Queues” page and ensure that the ZETADOCS_1 and ZETADOCS_2 job queues have been

created and are running. 

2. To start a job queue, check the box in the start column.

How the Batches are Processed

All the batches are processed in the background on the server. 

Note: Job Queue and Job Queue Category Lists are shared for all users in the same NAV database.

· When a user attempts to submit a job (by clicking on the Zetadocs Send button), Zetadocs checks that the Job

Queue Entries are running. This is to prevent unexpected delays after submitting batches for delivery.

· When a job is submitted, Zetadocs creates a new entry in the Job Queue Entries.

· This entry is queued in the Zetadocs Queue, and NAV schedules it for processing.

About the Entry

The entry contains the necessary information for Zetadocs to deliver the batch. When a batch is processed

successfully, the entry will be deleted from the database. 

If there is an Error in a Batch

If the batch has one or more errors, it will remain in the Job Queue Entries.You can open the Zetadocs Delivery

Outbox page if you need further information on the error. 

Retry a Failed Batch

Click the Retry button in the Zetadocs group on the Home tab to retry failed batches from the Zetadocs Delivery

Outbox. The status of the job will change to Processing and the job will be resubmitted. 

Zetadocs Queues are Run as the Administrative User

By default, both Zetadocs Queues run as the administrative user who imported the Zetadocs configuration settings

file. This account can be modified in the Job Queues list. By default the queues run within the default NAV service

(NST) that runs the NAV server. 

Running Queues on a Shared or Dedicated NAV Application

The Zetadocs Queues are designed to be run either within the default NAV service instance (NST) or a NAV

application server (NAS). See ZTN4474 Running Zetadocs server-side delivery on a NAS.

More Information

For more information on Job Queues, see the Microsoft Dynamics NAV help file.

http://www.equisys.com/technotes/ZTN4474.htm
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3. Scheduled Tasks (NAV 2017 and later or BC)

Note: This section is only applicable on NAV 2017 and later or BC, for Zetadocs server-side delivery. 

About Job Queue Category Lists 

Zetadocs provides one Job Queue Category List for each Scheduled Task. It creates two categories: one for single

delivery documents and another for batches containing multiple documents. 

Zetadocs Delivery Category and Zetadocs Batch Delivery Category are created during the Zetadocs configuration

settings import. These two categories ensure that the individual reports that need to be sent urgently don't get

held up by large batches. 

Any running batches with the Zetadocs Batch Delivery category, or individual emails being sent with the Zetadocs

Delivery category, can be viewed using the Zetadocs Delivery Outbox for the submitting NAV or BC user.  

How the Batches are Processed

All the batches are processed in the background on the server. 

· When a user attempts to submit a job (by clicking on the Zetadocs Send button), Zetadocs checks that the Job

Queue categories are created. This is to prevent unexpected delays after submitting batches for delivery.

· When a job is submitted, Zetadocs creates a new entry in the Job Queue Entries.

· This entry is queued as a Scheduled Task, and NAV or BC schedules it for processing.

About the Job Queue Entries

The Job Queue Entry contains the necessary information for Zetadocs to deliver the batch. When a batch is

processed successfully, the entry will be deleted from the database. 

If there is an Error in a Batch

If the batch has one or more errors, it will remain in the Job Queue Entries.You can open the Zetadocs Delivery

Outbox page if you need further information on the error or if you want to see individual information for a record

in a batch. 

Note that all records in a batch are processed independently, which means that if one record fails the batch will

continue to try and deliver the rest of the remaining records. 

Retry a Failed Batch

Click the Retry button in the Zetadocs group on the Home tab to retry failed batches from the Zetadocs Delivery

Outbox. The status of the job will change to Processing and the job will be resubmitted. 
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Running Tasks on a Shared or Dedicated NAV or BC Application

The Zetadocs server-side delivery is designed to be run either within the default NAV or BC service instance (NST)

or a NAV or BC application server (NAS). See ZTN4474 Running Zetadocs server-side delivery on a NAS.

More Information

For more information on Job Queues, see the Microsoft Dynamics help file.

4. Document Templates

Note: These settings are applicable on all NAV and BC versions. 

The final area of system settings we need to configure are the Template settings.

Before looking into the settings, we recommend you first familiarize yourself with templates and what they can

offer your system. 

About Templates

Zetadocs has a number of preconfigured document templates included within it to make setting up a system

quicker and easier. These templates contain Zetadocs stationery overlays, attachment documents, and a message

body, These have been constructed to provide a starting point from which to build and customize your system. 

For information on constructing your own templates or adjusting the Zetadocs Templates, open the Zetadocs

Client and view the help files. 

Note: If you are installing in a language other than English, you should first check the templates folder of your

product download. It contains a folder with sample templates specific to your language. 

Document Template Features

Attachments

The document template can include an attachment to allow you to include your own company specific

documents. For example, terms and conditions etc. This is in addition to the copy of the document being sent.

Note: Attachments must be in PDF format if using Zetadocs server-side delivery, in a server only or hybrid

installation. 

Stationery

A single stationery file can be used to add the company's branding to all documents being sent out. This means

you would only be required to update this stationery once for it to apply to all document templates.

http://www.equisys.com/technotes/ZTN4474.htm
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If using Zetadocs server-side delivery, in a server only or hybrid installation, the stationery file specified in the

template will be ignored. To add corporate branding, you should instead:

· Use NAV or BC Word Report layouts, or

· Modify the NAV or BC Report RDLC layout directly.

See the NAV or BC help topic "About Report Layouts" for more information. 

Message Body Text

The message body text contains a default message that forms the email message body and subject when the

document is sent using Zetadocs. This can be used with dynamics fields to populate information from NAV or BC

automatically into the email. This reduces the time required to process business documents. 

Sample Templates

To speed the setup of your system, we have provided a set of generic templates that can be used to quickly get

you up and running.

Attachments

No default attachments are included with the sample templates.

Stationery 

The sample templates all point to the same stationery file. This means that by updating this one file to match

your companies existing documentation, all documents sent by the system will be branded.

Message Body Text  

A default email message is provided for the main document types, with dynamic fields automatically populating it

with key data. These are shown in red in this example:

Subject: Order Confirmation for order number: 300381 for Equisys Ltd

Message Body:

FAO: John Smith

Dear Customer, 

I'm pleased to attach your order confirmation, reference number 300381. 

Kind regards, 

Sales Team

.

5. Template Settings

Note: These settings are applicable on all NAV and BC versions. 

Zetadocs has a number of preconfigured document templates included within it to make setting up a system

quicker and easier. Zetadocs will already have created entries for commonly used sales and purchase reports.
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It is usually simpler to modify these to match your requirements than to create new ones. These can be modified

in the Zetadocs Client.

Location of the Templates

The English language versions of the templates will have been copied to the Shared Network Folder you created

during the client installation.

If you are installing your system in another language, follow the steps below to replace these with the translated

templates:

1. Browse to your product download and select Zetadocs Server Components\Sample Templates\.

2. Select the language required.

3. Copy the templates to the Shared Network folder you created during the client installation for the templates.

The default location is:

\\<machine name>\Zetadocs Templates

Accessing the Template Settings

To access the Template Settings:

Version Action

NAV 2013 and later or BC Open the Windows Client and in the Navigation Pane

select Departments  >  Administration > Application

Setup > Zetadocs Setup  >  Zetadocs Template List.

 NAV 2009 Open the RTC or Classic client and navigate to

Administration > Application Setup > Zetadocs Setup >

Advanced Settings > Zetadocs Templates.

Changing the Template a Report Uses

You might want to change the template a report uses. For example: When you have a special offer, you might

want to send out Sales Orders for a period with special attachment and message. 

To create additional templates in the Zetadocs client and assign them:

1. Press the New button in the UI, or press the Edit button to edit an existing report. If you require further help on

this info, please visit the help in the Zetadocs Client Help.

2. Fill in the following fields in the form:
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Option Description

Template ID The ID specific to this particular template.

Path Contains the path to the folder which stores your

templates.

Name Contains the filename of the template to be used.

Description A description of the template, to help you identify it.

Next Step

This completes the setup of the standard delivery settings which apply across all documents. At this point, your

system should be setup to send out your business documents with the correct stationery, attachments and a email

personalized by dynamic fields. 

The next level of customization allows you to specify how each type of document is handled and how specific

customers or vendors have their document delivered. 

The next section will introduce delivery rules.

6. Introducing Delivery Rules

Note: These settings are applicable on all NAV and BC versions. 

When printing a Zetadocs enabled report, Zetadocs analyses each record in turn against the Delivery Rules. These

include details such as the recipient, delivery method (Email, Fax, Hard Copy), Archiving settings and the template

to apply. 

Zetadocs rules come in four levels. The rules are applied in ascending order when printing a document to Zetadocs.

The rule levels are:
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Level Description

1. The Default Rule A basic rule that can be used by any Zetadocs enabled

report.  

2. Per Document Set Specific settings for Zetadocs enabled documents by

type.

3. Per Company Specific settings for Zetadocs enabled documents by

company.

4. Per Company, Per Document Set Specific settings applied to specific document types

when sent to a specific company.

7. Testing Delivery Essentials

To test Zetadocs Delivery:

Note: Log into the Dynamics NAV Client with a Dynamics Full User license and a user role that has access to the

modified sections within NAV or BC.

Version Action

NAV 2015 and later or BC Follow Zetadocs Server-side Delivery testing.

NAV 2013 R2 and earlier Follow Zetadocs Client Delivery Testing  after first

completing How to modify Reports to work with

Zetadocs Client Delivery in the Appendix.

Zetadocs Server-side Delivery Testing

1. Open the Order Processing section or search for Sales Orders in the Dynamics NAV Client.

2. Select or create a suitable order record. 

3. Click the Send button in the Zetadocs section on the Actions Ribbon. This will attempt to send the currently

selected record by populating the No. filter in the filter page. The filter will be applied to the NAV or BC records.

If only one record remains, then the single delivery dialog window will be shown. Otherwise, the Zetadocs Batch

delivery will open. Note: Emails will be send to the corresponding addresses, please ensure that the email

address is correct before going to the next step. The test mode is only supported with Zetadocs Client Delivery.

4. On selecting OK an SMTP email message will appear in the Zetadocs Outbox briefly and disappear when sent

successfully.

5. Verify they are delivered as expected and archived (if archiving has been configured).
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Zetadocs Client Delivery Testing

Activating Test Mode

When testing Zetadocs, you can activate test mode to:

· Stop the report being sent to the Zetadocs Client Delivery. 

· Allow you to test the system without sending documents to customers.

Open the Zetadocs Report Settings page

1. Select the report you wish to put into test mode, and locate the Test mode checkbox.

2. Ensure this is checked for each report you are testing, 

Note: You will need to undo these steps when testing is complete.

Batch Send

1. Open the Order Processing section or search for Sales Orders in the Dynamics NAV Client.

2. Select a suitable range of records.

3. Select Print  >  Order Confirmation. A print dialog will appear. Select Print.

4. The Zetadocs Batch Delivery card may appear depending on your system settings. This will contain all of the

delivery details according to your current rule setup.

5. Select OK to send the reports. 

6. Verify they are delivered as expected and archived (if this has been configured).

Next Step

Important: Remember to deactivate the Test mode when testing is complete.

This completes the installation and testing of Zetadocs Delivery Essentials. If you are not installing Zetadocs

Capture Essentials, your setup is now complete. 

If you have installed the software on a test setup, go to the next section migrating to a live environment. 
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Capture Essentials Configuration
In this section, we will install the Zetadocs Server responsible for document conversion with Zetadocs Document

Queues and go through its configuration options.  

Please ensure you have carried out the steps in the Express Installation, as many of its components are required to

support Zetadocs Capture. Systems that are not implementing Zetadocs Capture Essentials can skip this section.

Version Action

NAV 2015 and later or BC Follow each section below.

NAV 2013 R2 and earlier Follow each section below unless specified to ignore.

The Capture configuration process comprises these steps:

1. Installing the Zetadocs Server

2. Configuring Document Queue Options

3. Configuring Capture Settings

1. Installing the Zetadocs Server

The Zetadocs Server monitors network folders setup for document queues and converts documents added to that

folder to PDF/A format before placing them in the document queue.

To install the Zetadocs Server:

Note: Zetadocs Server requires Microsoft .NET Framework 4.6 to be installed first. 

1. Download the latest version of the Zetadocs Server from the Software Updates page, and run the setup.exe

file.

2. Click Next and choose a destination folder for the installation and then Next.

3. You will be asked to choose whether you want to include OCR support. 

Note: OCR support requires additional Zetadocs Capture Plus licensing, the Zetadocs OCR Engine and have a

separate Zetadocs OCR Engine license number. 

o Choose the relevant option for your install and complete installing the Zetadocs Server:

§ I have a Zetadocs OCR Engine license number and would like OCR support. 

§ I do not have an Zetadocs OCR Engine license number.  

https://www.equisys.com/support/Updates.aspx?Product=Zetadocs%20Server&Version=Current
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4. If you would like OCR support, follow the steps relevant to your situation:

Situation Action

If you do not have an Zetadocs OCR Engine license and

don't need OCR support.

Go to Configuring Document Queue Options and follow

the steps described in that section.

If you have an Zetadocs OCR Engine license and you

would like OCR support.

Follow the instructions "installing OCR

Support" (described below) . 

Installing OCR Support

OCR support is provided using a third party solution provided by ABBYY. The Zetadocs OCR Engine installer is

responsible for installing the ABBYY OCR libraries and licensing services used by the Zetadocs Server for processing

barcodes and creating searchable PDF files.

To install OCR or barcode support:

1. Download the latest version of the Zetadocs OCR Engine from the Software Updates page.

2. Extract and run the Zetadocs OCR Engine download.

3. Choose a destination folder for the installation and then Extract.

4. On completion a setup program will automatically run and complete your installation.

Licensing the Zetadocs OCR Engine

Note: This step requires the Zetadocs OCR Engine license sent with your Zetadocs Capture Plus license certificate.

If you are installing the Zetadocs Server on an Microsoft Azure Virtual Machine (VM) then follow the steps in

Zetadocs OCR Engine Cloud Licensing below, otherwise follow Zetadocs OCR Engine Licensing.

Zetadocs OCR Engine Licensing (non-virtualized servers)

When the ABBYY License Manager opens automatically:

1. Click the Activate license... to starts the License Activation Wizard 

2. Enter your Zetadocs OCR Engine license number and activate your license.

Activation Methods

https://www.equisys.com/support/Updates.aspx?Product=Zetadocs%20Server&Version=Current
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Method Description

Via the Internet Activation is carried out automatically and takes only a

few seconds. An Internet connection is required for this

type of activation. 

By e–mail The user needs to send an e–mail message generated

by the program and containing information required

for activation. To ensure a quick reply from the mail

robot, do not alter the information in the message

body or Subject field. 

3. Now configure the Zetadocs Server by following Configuring Document Queue Options.

 Zetadocs OCR Engine Cloud Licensing (Azure VMs only)

1. Ensure you have received your Zetadocs OCR Engine Cloud Licensing files before continuing:

Files Description

password.txt Zetadocs OCR Engine password file. 

SWERxxx.ABBYY.ActivationToken Zetadocs OCR Engine activation token, where xxx will

be replaced with your unique Cloud license key.

 

2. Close the ABBYY License Manager when it opens automatically at the end of the installation. Do not enter the

Cloud license number as this type of license cannot be activated with the License Manager. 

Note: The ABBYY License Manager is still used to track page volume usage. 

3. Rename the file extension of the SWERxxx.ABBYY.ActivationToken file from ABBYY.ActivationToken to

ABBYY.Cloud.ActivationToken.

4. Copy your password file and the Activation token files into the Document Converter folder in the Zetadocs

Server installation path, for example C:\Program Files (x86)\Zetadocs Server\Document Converter.

5. Now configure the Zetadocs Server by following Configuring Document Queue Options.

2. Configuring Document Queue Options

Zetadocs comes with two Document Queues setup a standard, a Sales and a Purchase Document Queue, with

other custom queues available with Zetadocs Capture Plus. 

To configure the Zetadocs Server to communicate with the document queues, these first need to be configured.

Note: When outputting files into the Batchsplit folder, make sure these are not streamed into the folder as

Zetadocs Server will pick the file before its complete and it might deplete the Zetadocs OCR Engine license count.



Capture Essentials Configuration 35

© Equisys Ltd

Creating the Document Queue Folders

Each document queue requires a network folder. This folder is used to place captured documents for processing

and conversion, and you must provide users with the relevant permissions to access this folder. For optimal use of

the software, you should ensure that no process is locking or regularly accessing the files.

1. Create the required folders 

o e.g. Sales Document Queue

o e.g. Purchase Document Queue

Note: Each folder name must be unique and must not start with the same work.

2. View its Properties and ensure the Share this Folder checkbox is checked.

3. Select the Permissions button and assign the necessary permissions:

Permission Description

USERS Share permissions with a minimum of Change and Read

Permissions. Full Permissions are recommended.

SERVICE The Zetadocs Document Converter Service must have

access to the queue folders. To do this, add FULL

Permissions to the SYSTEM user (or as whatever

network user the service is running).

4. Make sure that the files will be dropped into the folder as entire files.

5. For better performance, please consider adding the folder path to the white list of any file management

process (i.e. anti-virus, synchronization software... ).

Document Queue Settings in NAV and BC

The Zetadocs Document Queue card will have been populated by the configuration file imported earlier with

default values. 

Open the Zetadocs Document Queue List page and select the Queue you wish to adjust. It will contain the

following fields:
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Field Description

No. The document Queue ID. 

You do not need to modify this. 

Name The name of the Document Queue. 

Edit as required.

Path The location of the document queue folder you

created in the previous step. 

Enter in the format \\example-server\Sales Document

Queue\.

Archive Documents Checking this option means all processed documents

will be archived.

Archive Original Checking this option means Zetadocs will archive the

original document rather than the version converted to

PDF. The conversion will still take place, ensuring that

any OCR or barcode recognition is still performed.

Delete After Archive Checking this option means documents will be deleted

from the document queue after being successfully

archived.

Show Delete Confirmation Checking this option determines whether a user is to be

asked to confirm deletion of documents.

Auto Link Documents Note: This is not supported with Capture Essentials.

Checking this option enables Auto Link functionality.

This determines whether the document queue will call

the GetAutoLink function in the Zetadocs-Send

Customize codeunit. 

This option must be checked if you are intending to use

OCR or barcode matching.

Check Out on View Checking this option means that when documents are

viewed in the document queue they are also checked

out.

The list at the bottom of the Document Queue card shows the menu items available to the user, when they click

the Archive button from the Zetadocs Document Queue form. 

Adding Document Queues to the Menusuite

To enable users to quickly access your document queues you can add them to your menusuite. To do this simply

follow the simple steps below.
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1. Open the object designer in the Dynamics NAV Development Environment.

2. Select the Zetadocs menusuite and click design.

3. Locate the area in the Navigation pane where you wish to add the item to the menusuite.

4. Right-click on the area and select Create item.

5. Select the object type of Page.

6. Select the Zetadocs Document Queue Page (ID: 9010000)

7. Select the Department as Lists

8. Click OK when satisfied and close the design pane.

9. Save and compile the Zetadocs menusuite.

10. Restart your Dynamics NAV Client.

Adding Document Queues to the Menusuite Navigation pane

1. Open the Dynamics NAV Client.

2. Click the down arrow located on the top left corner of the page ribbon and select Customize Navigation pane.

3. On the left pane, select Departments option.

4. On the right pane, locate the Zetadocs Document Queue option.

5. Click the Copy To option and select the Home option.

6. Accept the dialog that shows up.

7. Once the Dynamics NAV Client is restarted you should be able to see the Zetadocs Document Queue in the

Navigation Pane.

The Zetadocs Server Configuration File

The Zetadocs Server settings are modified using a Config.xml file, this is located in the Zetadocs Server installation

location. 

This is usually C:\Program Files (x86)\Zetadocs Server\Document Converter. 

You can open this file in a text editing program such as Notepad.exe. 

The Config.xml file contains settings which govern how documents are captured and added to document queues.

It consists of instructions for each document queue configured and more general options for capturing

documents. 

We will go through those options relevant to an Essentials install in the order they appear. Users can leave  the

default values unchanged for any options not described as Essentials.

Example 

In the example below:

· There is a Sales and a Purchase Document Queue each inside its own <DocsQ> </DocsQ>tags. 

· The general Zetadocs Server settings are below that. These Server settings apply to all queues. 
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In this section, we will go through the document queue specific options identifying what the options do and

providing suggestions for recommended defaults. Please go through each in turn to ensure your system is

configured properly. 

<?xml version="1.0" encoding="utf-8"?>
<Config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">

  <docsQueue>
     <DocsQ Description="Sales Document Queue" Location="\\User specified queue
location\Sales Document Queue\">
      <EnablePDFTextExtractionToFile>false</EnablePDFTextExtractionToFile>
      <BatchScanSplitType>Barcode</BatchScanSplitType>     
      <BatchScanPageInterval>1</BatchScanPageInterval>                            
      <BatchScanBarcodePrefix></BatchScanBarcodePrefix>                       
      <BatchScanBarcodeDeleteSplitPage>false</BatchScanBarcodeDeleteSplitPage>
      <FilenamePrefix></FilenamePrefix>    
   </DocsQ>
    
    <DocsQ Description="Purchase Document Queue" Location="\\User specified queue
location\Purchase Document Queue\">
      <EnablePDFTextExtractionToFile>false</EnablePDFTextExtractionToFile>
      <BatchScanSplitType>Off</BatchScanSplitType>                                
      <BatchScanPageInterval>1</BatchScanPageInterval>                                  
      <BatchScanBarcodePrefix></BatchScanBarcodePrefix>                           
      <BatchScanBarcodeDeleteSplitPage>false</BatchScanBarcodeDeleteSplitPage>
      <FilenamePrefix></FilenamePrefix>        
    </DocsQ>
 
  </docsQueue>
  
  <PDFQuality>Better</PDFQuality>
  <EnableAbbyy>true</EnableAbbyy>
  <StellentTimeOut>10</StellentTimeOut>
  <StellentBypassPDF>true</StellentBypassPDF>
  <LogLevel>Error</LogLevel>                                                      
  <LogToFile>true</LogToFile>
  <LogToEventLog>false</LogToEventLog>
  <EnableBarcodeDetection>true</EnableBarcodeDetection>
</Config>

The Zetadocs Server Config.xml file is Case Sensitive

WARNING: When setting the various options, please ensure that you copy the exact casing shown here. Failing to

do so may prevent the server from working as intended.

Specifying Document Queue Locations in the Zetadocs Server

· Items added into the Document Queue folders will be processed and converted to PDF/A format.

· Document Queue folders should be folders on the local machine where the Zetadocs Server is installed.

· The folder should then be shared on the network for Document Queue users to access.  
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Sample Code

<DocsQ Description="Sales Document Queue" Location="\\User specified queue location\Sales
Document Queue\">

Options

Element Description

Description Enter the name of the queue as specified in NAV or BC

earlier, it is already set to the default value.

Location Enter the Path to this queue as specified in NAV or BC

earlier on the Zetadocs Document Queue card.

PDF Text Extraction

· This option allows you to set the Zetadocs Server to extract text which can then be used by several Capture and

Delivery Plus elements. 

· Essentials users can leave this set to the default value of false. 

Sample Code

<EnablePDFTextExtractionToFile>false</EnablePDFTextExtractionToFile>

Options

Option Description

true Causes the Zetadocs Server to attempt to extract text

from documents, activating this option will slow down

the Zetadocs Server operation.

false This option stops the Zetadocs Server extracting text

from documents.

Batch Scanning Settings

· Each document queue can be configured to use only one type of splitting method when processing batches of

documents. 

· Select from the options below depending on how you wish to split batches, if at all.
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Sample Code: 

<BatchScanSplitType>Off</BatchScanSplitType>     

Options

Option Description

Off The default, the Zetadocs Server doesn’t process any

batches present in the Batch Split folder of your

document queue treating them as a single document.

Barcode Note: This is not supported with Capture Essentials.  

The Zetadocs Server splits the batches on every page

that contains a barcode.

BarcodeValue Note: This is not supported with Capture Essentials. 

The Zetadocs Server splits the batches every time the

barcode being read has a different value to the

previous barcode read.

PageInterval Zetadocs Server splits the batches using an interval

defined by the BatchScanPageInterval parameter, e.g.

every 3 pages see below for details.

Configuring the Page Interval

This value determines the page interval number to be used when processing a document using the PageInterval

splitting method described above.

Sample Code

<BatchScanPageInterval>1</BatchScanPageInterval>    

Options

· The page interval can be any positive whole number value (integer) e.g. 1,2,5,10,20 etc. The batch will then be

split into documents each that number of pages.

· For those not using page interval splitting, we recommend adding the value 1, as this will be ignored unless the

BatchScanSplitType has been set to PageInterval.

File Name Prefix

· It is often useful to be able to identify which Document Queue a document originated from following the

conversion and queue processing. 

· The file name prefix settings allows you to prefix all files processed by a queue. For example, a prefix setting of

“SDQ_” in the Sales Document Queue would result in a document “Sample.doc” becoming “SDQ_Sample.pdf”

after conversion to PDF.
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Sample Code 

<FilenamePrefix></FilenamePrefix> 

Options

· The default is no prefix. 

· To set a prefix put the appropriate prefix in the setting for the desired queue. 

· We recommend that the prefix value be less than 10 characters and the following characters are not allowed:

# % & * : < > ? / { | } ~ " '

Next Step

That completes the Zetadocs Server settings for a document queue, this process should be repeated for all

subsequent queues before continuing on to the general capture options.

3. Configuring Capture Settings

The general capture options for the Zetadocs Server are located at the bottom of the Config.xml file and contain

the options listed below. These are applied to all captured documents regardless of the document queue settings.

Adjusting the PDF Quality

The quality of the PDFs the Zetadocs Server produces during conversion can be adjusted to meet your

requirements of file size, quality and conversion speed. 

Sample Code

<PDFQuality>Better</PDFQuality>

Options

Option Description

Better Use this option when PDF quality is important, e.g.

when using OCR.

Smaller Use this option when storage space is at a premium

and high resolution is not required.

StellentTimeOut Option

Stellent is a component that helps with PDF conversion. This setting determines the duration Zetadocs will wait

before assuming it has a problem and aborting the conversion.
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Sample Code

<StellentTimeOut>10</StellentTimeOut>

Options

We recommend that this setting is left at its current default of 10.

StellentBypassPDF Option

This option causes the Zetadocs Server to bypass PDF files added to the conversion folder rather than convert

them again. They are instead simply copied to the converted folder, which can result in the Server operating more

quickly on a given batch of documents. 

Note: The PDF files may not be in the specific PDF/A format generated by the Server.

Sample Code

<StellentBypassPDF>true</StellentBypassPDF>

Options

Option Description

true The recommended default as PDF files will no longer be

converted which can increase the speed at which the

Zetadocs Server can process a batch of documents.

false Sends all documents for conversion including those

already in PDF format.

Adjusting the Logging Level

The logging level options can normally be left set to error, with the other options only used in troubleshooting and

support cases.

Sample Code

<LogLevel>Error</LogLevel>      

Options

Message type Description

Error Use this setting for general operation.

Warning Use this for trouble shooting issues.

Debug Should be used for a controlled period of time to

trouble shoot issues.   



Capture Essentials Configuration 43

© Equisys Ltd

Specifying the Log Location

The Zetadocs Server log can be set to save to a file and/or the event log. This is done using the two options

<LogToFile> and <LogToEventLog>. Using these options is is possible to set Zetadocs to log to either a file or

the event log or neither.

The Zetadocs Server log file is written to:

C:\Windows\Temp\Zetadocs\ZdDocumentConverter.log

Sample Code

<LogToFile>true</LogToFile>

<LogToEventLog>false</LogToEventLog>

The above code would result in the log being kept in Zetadocs Server log file.

Options

Each of the can be set to either true or false, we recommend that you have one or the other forms of logging

active at all times.

Option Description

true Logs event at the level specified above to the log file

or event log.

false Stops the Zetadocs server logging events into the log

file.

Restarting the Zetadocs Server

Save the updated Config.xml file when you have finished making your changes.To implement the changes you

have made, you need to restart the Zetadocs Server. 

To restart the Zetadocs Server:

1. Go to Start > Run. Then enter Services.msc.

2. Scroll to Zetadocs Document Converter. 

3. Right click on Zetadocs Document Converter, and select Restart.

4. Testing Capture Essentials

To test Zetadocs Capture:
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Note: Log into the Dynamics NAV Client with a Dynamics Full User license and a user role that has access to the

modified sections within NAV or BC.

Version Action

NAV 2015 and later or BC Follow the steps below

NAV 2013 R2 and earlier No additional actions, follow the same steps below.

Zetadocs Server Extensions install the Zetadocs Control add-in to support all clients without any further

installation on each client PC. This means the same Zetadocs Documents FactBox is now available on all NAV/BC

clients, include the Web client and Universal app.

Zetadocs Document Queue Testing
The Sales and Purchase Document Queues have the capacity to generate a number of different documents within

NAV or BC. These are predetermined, and you should do a test for each that you intend to implement in the

system. 

Creating a Document using the Sales and Purchase Document Queues

1. Open Dynamics NAV Client and open the Zetadocs Sales Document Queue.

2. Ensure the queue is populated with a selection of sample or test documents.

3. Select one of the items from the queue.

4. Select Create and then the type of document you wish to test. In this case, we’ll look at a Quote.

5. This will display the Sales Quote window. Fill in the form as usual and when finished. 

6. Close the Sales Quote window. 

o The Zetadocs Status Message is displayed advising you that a copy of your document that you have just

processed from the Zetadocs Document Queue, has been saved in the archive. It will also give you the archive

location. 

7. You will be asked whether you want to delete the document from the document queue. If you no longer

require the document to be in the Document Queue, you can delete it. You can always go back to the archive

location where the document was saved to view it.

8. Repeat this process for the other Sales items and the Purchase queue as required.

9. Open your archive and ensure the documents have been archived as expected.

Test Shared Location Updating

1. Create an email with an attachment and save it as a .msg file into the Zetadocs Document Queue’s shared

folder location.

2. Select the Queue > Refresh menu button and ensure that the saved email.msg file is now in the Document

Queue converted into PDF format.

3. Select the entry in the Zetadocs Document Queue and click Item > View. Verify the item is viewable in PDF

format

4. Select the entry in the Zetadocs Document Queue and click Item > View Original. Verify the item is viewable in

its original format.
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Check Delete

1. Select an entry in the Zetadocs Document Queue and click Item > Delete. 

2. Verify the document is removed from the Queue and also that it successfully deletes the file from the

Zetadocs Document Queue network folder location.

Next Step

This completes the installation and testing of Zetadocs Delivery and Capture Essentials. If you are not installing

any Advanced features, your setup is now complete. 

If you have installed the software on a test setup, go to the next section migrating to a live environment. 
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Appendix

Migrating to the live database

How to install Zetadocs Client on a client PC

How to install Zetadocs Client using ClickOnce

How to manually install the Zetadocs Control Add-in for NAV2016 and later or BC

How to Modify reports to work with Zetadocs Client Delivery

How to add support for NA Customer Statements (10072) with Zetadocs server-side delivery

Additional Archiving information

Creating SharePoint Document Libraries for Zetadocs

Zetadocs Updates and Uninstall

Migrating to the Live Database

To migrate your setup to your live system, you need to: 

1. Export the Configuration.

2. Export any Modified Forms, Pages, Tables and Reports.

3. Import Zetadocs to the Live NAV or BC System:

a. Import the Zetadocs Objects.

b. Import any Modified Forms, Tables or Reports.

c. Import the xml file with your configuration.

Exporting the Configuration

The Zetadocs Configuration Export form will export all of the configuration data specific to Zetadocs. If you have

modified data in other tables, this will not be exported.

1. From the Navigation pane select the Administration option.

2. From the options that appear, select Application Setup and then Zetadocs Setup.

3. Select the Zetadocs Configuration Export option.

4. In the window that appears select a suitable name and location for your configuration export and click Export. 

Exporting Modified Forms, Pages, Tables and Reports. 

1. Open the Object Designer (Tools > Object Designer). 

2. Click on All button in the designer menu. 

3. Select All objects (CTRL + A) or alternatively select those objects you wish to export. 
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4. Export the Objects (File > Export) to a suitable file e.g.  Zetadocs Export.fob file.

5. Keep the Zetadocs Export.fob in a safe place. 

Importing Zetadocs to the Live NAV or BC System

When moving to the live system, instead of importing the config.xml file and pages/tables/forms.fob files straight

from the Zetadocs product download, you select the files you created during the exports above. 

To import:

1. Import the Zetadocs Objects fob file created from you test system

2. Install the Page interfaces and forms as required

3. Import the xml file with your configuration from the test system

4. Copy across your Zetadocs Templates

When you have imported the configuration, you should perform a brief series of tests like those conducted earlier

to ensure that the migration has been successful.

How to Install Zetadocs Client on a Client PC

Installation Steps to be Performed on Each Client Machine

Note: This should only be completed after the Express Installation.

The following steps are only required on each client machine if you require Zetadocs Client functionality: 

1. Installing the Zetadocs Client

2. Zetadocs Client Licensing

3. Installing the Zetadocs Help files.

4. Testing the Zetadocs Solution. See:

o Testing Zetadocs Express

o Testing Delivery Essentials

o Testing Capture Essentials

Zetadocs Client Licensing

1. Start the Zetadocs Client.

2. Go to Tools> Options> Licensing and enter the path to the network folder containing the Zetadocs license.

3. Restart the client if necessary, you can confirm that you are successful if the splash screen shows the

Automation tag beside the number of users.

4. Please refer to the Zetadocs Client Help for further information on configuring the Zetadocs Client.
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Zetadocs Help files (NAV 2013 and earlier)

Windows Client/Role Tailored Client 

The Zetadocs help files need to be copied to the NAV help folder on each machine. The file names should use the

first unused post-fix letter between a and j (e.g. change to addin_b.chm and addin_b.hh if addin_a.chm exists). 

The destination of these files is determined by the install language e.g. substitute the en-GB subfolder shown in

the examples below for the language pertinent to the install e.g. en-US for US systems.

There are 2 files to copy:

·  .chm file, and 

·  .hh file 

These are available from your product download in the folder:

 \Zetadocs Client\ Help

Copy the .CHM files to the following location:

Version Location

NAV 2013 Program Files (x86)\Microsoft Dynamics

NAV\70\RoleTailored Client\en-GB

NAV 6.0  Program Files (x86)\Microsoft Dynamics

NAV\60\RoleTailored Client\en-GB

Copy the .hh file to the following location:

Version Location

NAV 2013 Program Files\Microsoft Dynamics

NAV\70\Service\ENG

NAV 6.0  Program Files (x86)\Microsoft Dynamics

NAV\60\Service\ENG

You may need to restart the NAV Server to get the help files to appear.

1. Go to Start > Run, type services.msc, and then press ENTER.

2. Under Services, right-click the NAV Server, and then click Restart.



Appendix 49

© Equisys Ltd

Development Environment/Classic Client

The Zetadocs help files need to be copied to the NAV help folder on each machine. The file names should use the

first unused post-fix letter between a and j (e.g. change to addin_b.chm and addin_b.hh if addin_a.chm exists).

The destination of these files is determined by the install language e.g. substitute the en-GB subfolder shown in

the examples below for the language pertinent to the install e.g. en-US for US systems

There are 2 files to copy:

·  .chm file, and 

· .hh file 

These are  are available from your product download in the folder:

 \Zetadocs Client\Help\

Copy the file to the following location:

Version Location

NAV 2013 Program Files\Microsoft Dynamics

NAV\70\Service\ENG

NAV 6.0  Program Files\Microsoft Dynamics

NAV\60\Classic\ENG

You may need to restart the NAV Server to get the help files to appear.

· Go to Start > Run, type services.msc, and then press ENTER.

· Under Services, right-click the NAV Server, and then click Restart.

How to Deploy Zetadocs Client using ClickOnce

To deploy Zetadocs Client with 32-bit Windows Client, you need to follow the steps below:

Version Action

NAV 2016 and later or BC No actions required. Zetadocs Server Extensions install

the Zetadocs Control add-in to support all clients

including the Dynamics NAV clients (32 and 64-bit)

without any further installation on each client PC. 

NAV 2013 R2 and NAV 2015 Follow the steps below.

NAV 2013 and earlier No actions required. ClickOnce feature not available. 
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· Step 1: Installing Zetadocs.

· Step 2: Update the Deployment manifest.

Step 1: Installing Zetadocs

1. After installing Zetadocs in the NAV or BC Server, copy the Zetadocs Capture Add-in Folder to the NAV or BC

deployment location.

The Zetadocs Capture Add-in Folder is typically located in the NAV or BC Add-ins folder:

C:\Program Files (x86)\Microsoft Dynamics NAV\xx\RoleTailored Client\Add-ins

C:\Program Files (x86)\Microsoft Dynamics 365 Business Central\xx\RoleTailored Client\Add-ins

The NAV or BC deployment location is:

C:\inetpub\<CLICKONCEDEPLOYMENT>\Deployment\ApplicationFiles

(Replace <CLICKONCEDEPLOYMENT> with the name of your NAV or BC deployment.)

2. Go to the assemblies folder by opening Run and enter:

C:\Windows\assembly\GAC_MSIL

3. Find the folder Microsoft.SharePoint.Client.

4. Copy the Microsoft.SharePoint.Client.dll found inside the Microsoft.SharePoint.Client folder to the NAV or BC

deployment location. This is typically: 

C:\inetpub\<CLICKONCEDEPLOYMENT>\Deployment\ApplicationFiles

5. In the assemblies folder, find the folder Microsoft.SharePoint.Client.Runtime and copy the

Microsoft.SharePoint.Client.Runtime.dll to the NAV or BC deployment location.

6. In the assemblies folder, find the Microsoft.SharePoint.Client.Runtime.Resources folder and copy the

Microsoft.SharePoint.Client.Runtime.Resources.DLL found inside to the NAV or BC deployment location.

Additional steps for NAV 2016 and later or BC:

1. Remote desktop to the NAV or BC server.

2. Backup your deployment folder (e.g. C:\inetpub\<CLICKONCEDEPLOYMENT>) to a different location.

3. Navigate to the location of your NAV or BC deployment. For example:

C:\inetpub\<CLICKONCEDEPLOYMENT>\Deployment\ApplicationFiles

4. Delete the following files:

o Microsoft.Dynamics.Nav.Client.exe

o Microsoft.Dynamics.Nav.Client.exe.config
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5. Navigate to your Dynamics NAV or BC RTC installation folder typically in C:\Program Files (x86)\Microsoft

Dynamics NAV\xx\RoleTailored Client and copy the following files:

o Microsoft.Dynamics.Nav.Client.x86.exe

o Microsoft.Dynamics.Nav.Client.x86.config

6. Paste the files into the folder:

C:\inetpub\<CLICKONCEDEPLOYMENT>\Deployment\ApplicationFiles

7. Rename the file Microsoft.Dynamics.Nav.Client.x86.exe to Microsoft.Dynamics.Nav.Client.exe

8. Rename the file Microsoft.Dynamics.Nav.Client.x86.exe.config to Microsoft.Dynamics.Nav.Client.exe.config

Step 2: Update the Deployment Manifest

Before starting the following steps make sure you have the following tools on the NAV or BC Server:

o mageUI.exe

o mage.exe (This is part of the default ClickOnce scripts provided by Microsoft)

Follow the steps below to update the deployment manifest:

1. Start by opening mageUI.exe.

2. Go to File -> Open and select the file Microsoft.Dynamics.Nav.Client.exe.manifest:

C:

\inetpub\

<CLICKONCEDEPLOYMENT>\Deployment\ApplicationFiles\Microsoft.Dynamics.Nav.Client.exe.manifest

3. Go to the Name tab and in the Advanced section change the Processor to x86:
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4. Go to the Files tab and click Populate.

5. Save the manifest and if a warning shows select ‘Yes’ to continue.

6. A prompt to sign the manifest should appear. Select a certificate file and click OK to sign the manifest and

close the dialog.

Note: More information on how to obtain a certificate can be found in Using Certificates to Secure a Remote

Client Connection.

7. Close mageUI.exe.

8. Open the manifest file with Notepad or similar.

9. Find the line 

<assemblyIdentity name="Tracker.PDF-XChange.25" version="1.0.0.0" processorArchitecture="X86"

type="win32" />

10. Replace “X86” with “x86”.

11. Save the file and close Notepad.

12. Open the Command Prompt as an Administrator and change directory to your ClickOnce deployment

Application Files folder:

C:\inetpub\<CLICKONCEDEPLOYMENT>\Deployment\ApplicationFiles\

https://msdn.microsoft.com/en-us/library/gg502457(v=nav.90).aspx
https://msdn.microsoft.com/en-us/library/gg502457(v=nav.90).aspx
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13. Run the following command (replace certFile.pfx with your certificate and password with its password):

mage.exe -Sign Microsoft.Dynamics.Nav.Client.exe.manifest -CertFile certFile.pfx -Password password

14. Open mageUI.exe again and open the application file:

"C:\inetpub\<CLICKONCEDEPLOYMENT>\Deployment\Microsoft.Dynamics.Nav.Client.application"

15. Go to the Name tab and in the advanced section change the Processor to x86.

16. Go to the Application Reference tab and click the Select Manifest button and select the manifest file changed

previously.

17. Save and Sign the application file.

Testing

To test the deployment:

1. Go to the URL of the deployment and open a page that has been modified to have the Zetadocs FactBox. 

2. Verify the FactBox can open without errors and test that a document can be saved using the FactBox.

How to manually install the Zetadocs Control Add-in

This section will explain how to manually install the Zetadocs Control Add-in for NAV 2016 and later or BC.

1. Open the Dynamics NAV Client

2. Search for the "Control Add-ins" page

3. Add a new Addin entry by clicking on the button "New"

4. Enter the following information:

a. Add-in Name:        Zetadocs.ControlAddins.Web

b. Public Key Token:   e139abe62dd951e0

c. Category:           JavaScriptComponent

5. Select the created line

6. Click on "Import" and browse for the Zip file Zetadocs.ControlAddins.Web.zip provided

7. Close the client.

How to Modify Reports to work with Zetadocs Client Delivery

Zetadocs Report Modification Tool for Zetadocs Client Delivery

Note: These sections are only required for Zetadocs Client Delivery. 
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Zetadocs requires existing NAV and BC reports to be modified to add the Zetadocs reference that the Zetadocs

PDF printer interprets as the start of the next document in a batch. To make this process quicker and easier, we

have provided the Zetadocs Report Modifier tool.

Prerequisites

· The Tool is not guaranteed to work for all NAV and BC reports. If you encounter any problems with the tools,

follow the technical note to modify the reports - ZTN4448 - provided on the website. We also provide manual

instructions on how to modify remittance advice reports - ZTN4375 - and Word layout reports for NAV 2015 -

ZTN4376.

· The tool does not perform all the changes required for Windows Client reports. To modify Windows Client

reports, we recommend running the reports through the tool and then performing the additional edits detailed

below.

Using the Report Tool

1. Download the latest Report Modification Tool from the Equisys website and extract it.

2. Open the Object Designer and select the reports you wish to add Zetadocs functionality. 

3. Export the reports as a text file.

4. Run the Tool and click Load Reports. 

5. Select the version of NAV or BC.

6. Browse to your exported reports and click Start. The Conversion Options window will appear. 

7. Modify the new report ID range as required. 

o This specifies the starting ID that the Report Modification Tool will use for the first modified report.

Subsequent reports will use values incremented from this base value.

8. Modify the report name prefix, as required. 

o This specifies a 0 to 3 character prefix that all reports will have appended to their names. This ensures the

reports have a unique name. Leaving the prefix blank will allow the existing report name to be used. However,

you may get name collisions if you have chosen to use new report IDs as well.

9. You may be asked to delete the existing output directory. We recommend you back up this directory before

proceeding.

10. If a report cannot be modified, the reason will be listed. For successful conversions, the new report ID and report

name are given.

11. The modified reports are now available in the folder containing the original reports, in an Output subfolder.

12. Re-import the reports and deal with any merge and conflict messages that appear.

RDLC Layout Modifications

If you are using the RDLC reports, you need to perform these additional steps to ensure the Zetadocs reference is

visible to the Zetadocs PDF printer. 

There are two different methods to do this, depending on how it has been designed and the version of NAV or BC in

question:

http://www.equisys.com/technotes/ztn4448.htm
http://www.equisys.com/technotes/ztn4375.htm
http://www.equisys.com/technotes/ztn4376.htm
https://www.equisys.com/support/knowledgebase/zdnav.htm?Product=Page%20Modification%20Tool
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· Modifying the Header and Body section

· Modifying the Body section only

Most can use the header and body section modifications, but some reports (for example, the remittance advice

journal) require the body only modifications.

NAV and BC Modifying the Header and Body Section

The Order confirmation report is an example where the page header section is used to display header information

on each page for the record. 

To add the Zetadocs reference:

13. Locate the report and click View > Layout. This will open the report designer.

14. Add a new text box in the top left of the body section, ensuring it does not overlap any existing controls. 

o Existing text boxes have a parent listbox called list1. In this situation, ensure that this new textbox has the

same.

15. Adjust the properties as follows:

o Name: Zetadocs_Reference_tb.

o Value: =Fields!Zetadocs_Reference.Value.

o Visibility Hidden: TRUE.

o Color: Red.

16. Open the Document Outline – Report window (Visual Studio  >  View  >  Other Windows  >  Document Outline). 

17. Locate the Zetadocs_Reference_tb texbox.  

18. Click the Bring to front button. 

19. Add a new text box to the top left of the page header section of the report.

o Ensure the textbox does not overlap any existing controls.

o Ensure the whole 15 digit ZD Reference will fit in the text box on one line.

20. Adjust the properties as follows:

o Font size: 6 (4 being the minimum)

o Color: White

o Value: =ReportItems!Zetadocs_Reference_tb.Value.

21. Close and save the report.

Version Code

When you have saved the report, add EQ9.0 to the Version List column in the Object Designer. 
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NAV 2009 Modifying the Body Section Only

The remittance advice journal report is an example of a report that does not have a page header section. In this

situation, follow the instructions below to add the Zetadocs reference. Additional help for remittance advice

reports can be found online in the knowledgebase.

To add the Zetadocs reference:

22. Click View > Layout to open the report designer for Dynamics NAV Client reports.

23. Add a new text box into the top left  of the header section.

o Ensure the textbox does not overlap any existing controls.

24. Usually existing text boxes have a parent listbox called list1. In this situation, ensure this new textbox has the

same.

25. Adjust the properties as follows:

o Font size: 6 (4 being the minimum)

o Color: White

o Value: =Fields!Zetadocs_Reference.Value.

26. Close and save the report.

Version Code

When you have saved the report, add EQ9.0 to the Version List column in the Object Designer. 

How to add support for NA Customer Statements (10072)

This section explains how to add support for the North American Customer Statement Report(10072) or reports

based on 10072. These reports require an extra filter not required by the standard Customer Statement reports

(116 or 1316).

Note: The following steps are only required for Zetadocs server-side delivery functionality.

To add support for report 10072 follow these instructions:

1. Open the NAV or BC Development Environment and go to table 9009965 - Zetadocs Report Settings and click

'Run'.

2. Add a new entry for the required report (e.g. 10072).

3. Populate the fields as below:
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Report ID 10072

Report Name Statement

Document Set No. ZD00012

Document Set Name Statements

Archive Document Type

Company Type Code CUST

Company No. Field No. 1

Contact No. Field No. 5049

Default Batch Name

Show Delivery Dialog true

Show Batch Delivery Dialog true

Preview in Zetadocs Client true

Test Mode False

Record No. Field No. 1

Comments

Report Table ID 18

Report Table Filter

Report DataItem Name Customer

Consolidate E-Mails Limit 0

Consolidate E-Mails false

Enable Additional Filter true

Additional Filter

4. Click 'Ok' to close the window.

5. Test by sending a Customer Statement and verify that no error is shown.



Zetadocs Installation Guide58

© Equisys Ltd

Additional Archiving Information

SharePoint

SharePoint ListView Thresholds

Microsoft SharePoint currently has a maximum limit for the number of items in a Library. Items can be documents

or folders. When planning your Archive file plan, you should take into account this limitation by splitting items into

multiple lists so that no list exceeds 5,000 items. You'll be unable to view the list items beyond the limit of 5,000

items. 

Zetadocs Essentials allows you to configure your archive folder structure by changing the archive options in the

General settings page.

In order to help you create a more customizable file plan, you can use Zetadocs Capture Plus. This will allow you to

archive different documents to different places depending on a custom logic, giving you more control over your

stored files and file plan.

Custom File Plan

The Zetadocs-Capture Customize Codeunit contains an example in the PreArchive function to create a custom

folder structure. The example shows how to create a folder structure based on a root folder name, the transaction

type, and then the name of the customer or vendor. 

This example can be uncommented to get something working immediately and then extended to meet your

need. More information on how to use the Zetadocs SDK can be found in the Zetadocs SDK guide.

The Zetadocs SharePoint Content Type and its Columns

Zetadocs includes a SharePoint solution package (.wsp) to bundle Zetadocs features. You can find it in your

product download under the Zetadocs SharePoint Extensions folder. This package contains a Zetadocs Content

Type which is required for Zetadocs to archive documents into your SharePoint Document Library.

The Zetadocs Content Type contains different SharePoint columns depending on the version of the Zetadocs

SharePoint Extensions installed in your SharePoint site. 

Note: There may be columns hidden that are not displayed in the Microsoft SharePoint user interface. 

The following table shows the name of the column, the hidden property, its data type and the supported version:
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Variable name Hidden column Data type Supported version

ZetadocsBcc No Text Available for version 4.2 of

Zetadocs or later

ZetadocsCc No Text Available for version 4.2 of

Zetadocs or later

ZetadocsDateReceived No DateTime Available for version 4.2 of

Zetadocs or later

ZetadocsDateSent No DateTime Available for version 4.2 of

Zetadocs or later

ZetadocsEmail No Text Available for version 4.2 of

Zetadocs or later

ZetadocsFax No Text Available for version 4.2 of

Zetadocs or later

ZetadocsFrom No Text Available for version 4.2 of

Zetadocs or later

ZetadocsCompanyNo No Text Available for version 4.2 of

Zetadocs or later

ZetadocsRecordNo No Text Available for version 4.2 of

Zetadocs or later

ZetadocsRecordType No Text Available for version 4.2 of

Zetadocs or later

ZetadocsOrganization No Text Available for version 4.2 of

Zetadocs or later

ZetadocsPrinter No Text Available for version 4.2 of

Zetadocs or later

ZetadocsRecipientName No Text Available for version 4.2 of

Zetadocs or later

ZetadocsArchiveID No Text Available for version 4.2 of

Zetadocs or later

ZetadocsDocumentType No Text Available for version 4.2 of

Zetadocs or later

ZetadocsRecordLink  Yes Text Available for version 5.0 of

Zetadocs or later

ZetadocsRecordLinkType Yes Text Available for version 5.0 of

Zetadocs or later
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If you intend to move documents archived using Zetadocs in your Microsoft SharePoint from a Document Library

to another, you must copy all the Zetadocs columns. This must include the hidden columns.

Adding the Zetadocs SharePoint Extensions

The Zetadocs SharePoint Extensions create a document library called Zetadocs by default and enables it for

operation with Zetadocs. To install the Zetadocs Server Extensions to your SharePoint, you need to:

1. Locate the Zetadocs SharePoint Extensions folder of your product download.

2. Run the sharepointonlinemanagementshell_5326-1200_x64_en-us.msi to install the SharePoint Online

Management Shell.

3. Open the Sharepoint Online Management Shell as administrator.

4. From the shell browse to the Zetadocs SharePoint Extensions folder and type .\SharePoint Extensions.ps1 to

run the Zetadocs SharePoint Extensions.ps1 file.

5. Follow the steps in the script:

a. Enter the URL for the site where the Zetadocs functionality is required (for instance

https://company.sharepoint.com/mysite/)

b. Enter an administrative user email

c. Enter the password for the administrative user

6. The script will log out information, the text should be green and white. If there is any red text, please verify the

error and take the required action to resolve if the error message is clear. If required, please contact Equisys to

resolve any unclear errors.

Creating Document Libraries for Zetadocs

The Zetadocs SharePoint Extensions create a document library called Zetadocs by default and enables it for

operation with Zetadocs. Should you wish to create a different document library then you will need to follow the

steps below to ensure you get the full range of Zetadocs functionality.

NOTE: You must activate the Zetadocs site features prior to performing these settings on the site where you want

the new document library.

1. Create a new document library on the site.

2. Open the Document Library settings > Advanced Settings.

3. Set Allow management of content types option to Yes.

4. Return to the Document Library settings and select Add existing content type and then Zetadocs in the

Content Types section.

Should you wish to enable the basic approval workflow feature then you will need to perform these additional

steps:



Appendix 61

© Equisys Ltd

1. From your new Document Library ribbon browse to the library Workflow Settings.

2. Click on Add a workflow ensuring the These workflows are configured to run on items of this type option is set

to All.

3. From the workflow list select the Approval - SharePoint 2010 option.

4. You must name the workflow Zetadocs.

5. Complete the workflow creation and to complete the setup you must upload a document to the document

library and run the Zetadocs workflow on it. 

Updating Zetadocs

FOB Independent Updates

All Zetadocs updates and update rollups allow for the Zetadocs Client and Zetadocs Server Extensions to be

updated independently of the Zetadocs objects. This will bring an easier update process for customers, as they can

update Zetadocs without having to require their Dynamics partner to access the Dynamics NAV development

environment. 

For detailed instructions on how to update your Zetadocs, see the Equisys updates page.

http://www.equisys.com/updates
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Enabling ForceSearchByRecordLink option

If you are updating from 5.0 or 5.4 to 9.0 of Zetadocs and you previously had Zetadocs version 4.x installed, you

need to complete these steps:

1. Open Dynamics NAV development environment and then the Object Designer.

2. Locate and run the Zetadocs System Settings table (ID:9009959).

3. Add a new record called ForceSearchByRecordLink, check the bool field and close the table.

4. This will instruct Zetadocs to search your archive for items archived using the RecordLink method.

5. Create Index in SharePoint (for SharePoint users):

o Zetadocs SharePoint Extensions does not create an index for the Zetadocs Archive ID automatically. 

o We recommend you to create it manually to improve the performance of your system. To create it, follow the

instructions in technical note ZTN4398, related document search fails in SharePoint when any document

library contains more than 5000 documents.

Enabling Zetadocs Capture Plus for Zetadocs Document Factbox

When updating Zetadocs from versions 7.1 or earlier the Zetadocs Document Factbox will not call the PreArchive

function in the Zetadocs Capture Codeunit by default. 

To enable this feature:

1. Open the Dynamics NAV development environment and run the table 9009959 Zetadocs System Settings.

2. Add a new entry FactboxSDKEnabled.

3. Set the Bool value to true(ticked).

4. Close the page.

You should now be able to use the Zetadocs Capture Customize codeunit for the documents archived using the

factbox.

Uninstalling Zetadocs

Please follow the instructions on the technical note ZTN4272, on how to uninstall your Zetadocs.

Further Resources

To keep this guide as simple as possible, we have focused on the standard installation requirements. 

See Latest Advice and Resources to access the latest technotes, updates and tools to support your installation. 

http://www.equisys.com/technotes/ztn4398.htm
http://www.equisys.com/technotes/ZTN4272.htm
http://www.equisys.com/support/knowledgebase
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We recommend you view this page to ensure you are working with the most up to date software and advice. It also

provides general advice and specific advice for special install scenarios, such as Upgrades, Group Policy and Remote

Desktop Services installations.
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